A joint analysis involves the determination of whether the bolted joint and an individual bolt comprising the joint can sustain the forces being applied. This analysis can include both a torque analysis and a thread stripping analysis if these are relevant to the joint design. The analysis involves determining the joint characteristics and its response to applied forces.

The Joint Analysis module of the program will check the likelihood of failure by any one of five mechanisms:
1. The bolt preload being insufficient to resist the applied forces.
2. The bolt being directly over loaded by the applied forces.
3. Fatigue failure of the bolt.
4. Excessive bearing stress under the nut face, bolt head or within the joint itself.
5. Thread stripping of the internal or external threads.

The program allows a comprehensive model of the joint to be created. By being comprehensive, complex joints require quite a lot of data relating to the joint to be entered. The following slides show examples of analyses demonstrating some of the program’s capabilities.

(Above) Start BOLTCALC ensuring that the units are set to the appropriate units (metric or inch). On the main menu do to ‘Analysis Type’ and then click on the entry marked ‘Joint Analysis’.

(Side) The Joint Analysis Data Entry Form will open. Different pages on this form can be accessed by clicking on the tab at the top of the form. To go to the Remarks page - click the Remarks tab. On this page - reference information can be entered that will be displayed with the results. Entering data on this page is optional.

The Title of the Analysis will be used on graphs displayed and in the main heading of the results. The other entries such as Remarks, Job Reference Details etc. can be used to reference the analysis.

In the Recommendations/Notes section, information relating to the analysis will be stored. This will be displayed with the results. These notes can be as long as you wish. They are stored by the program (when the data is saved) in a file with a .txt extension having the same name as the data file that you save the data under.

(Side) The Forces page contains details relating to the forces that are applied to the joint.
Joint Analysis using the BOLTCALC Program (continued)

(Above) The Bolt Details page contains information about the fastener size being used.

(Above) The Property Details page contains information about the fastener strength. Other forms can be opened to provide additional information by clicking on the appropriate button.

(Above) Specific details about the joint are entered via the Joint Details page. Other data entry forms can be opened from this form.

(Above) The Tightening Details page allows data to be entered on how the joint is to be tightened and tightening related information.

(Side) If the Calculate button is pressed before all the data is entered, or alternatively invalid data is entered (such as the clearance hole being bigger than the nut diameter), an error message will be generated by BOLTCALC.
Joint Analysis using the BOLTCALC Program (continued)

Simple Example Calculation - Metric Units

(Side) An M12 property class 10.9 bolt secures the joint shown. The joint plates are made from steel having yield strength of 500 N/mm². Will there be any problems with the joint?

The finish is Dacromet, and the fastener is to be tightened using a torque wrench. The clearance hole diameter used is 13 mm.

(Below) Start BOLTCALC ensuring that the units are set to metric. On the main menu do 'Analysis Type' and then click on the entry marked 'Joint Analysis'. On the Forces page, enter 20000 as the Axially Applied Force. To determine the value needed for the clamp force to resist shear loading, click on the button marked 'Additional Assistance on Shear Force Determination'.

(Below) On the Shear Force form enter 0.15 as the friction coefficient and 2000 as the applied shear force. Press the Calculate button to determine that a clamp force of 13333 N is required to prevent slip. Click 'Ok' button to close the form.

(Side) Click on the Bolt Details tab at the top of the form to change pages. Click on the button marked 'Select Thread Size from a Database' and select the M12 x 1.75 thread. Details about this thread will be transferred onto the main form as shown. Enter the clamp length as 50 mm.
Joint Analysis using the BOLTCALC Program (continued)

(Side) On the Property Details page of the form, click on the button marked ‘Consult the Fastener Material Database’ and select the 10.9 property class that appears. Leave other entries on this page at their default values.

(Below) On the Joint Details page, enter 500 for the value of the limiting surface pressure. Except the default values on the rest of the page.

(Side) The values on the Tightening Details page can be accepted at their default values since they are appropriate for this example. Click the ‘Calculate’ button.

(Below) The results will be displayed on the main form. To check that the joint entered corresponds to what you think it should be – click the speed button shown to display a joint drawing – or alternatively – click the View menu option.

(Below side) A drawing of the joint will be displayed. To view other charts - click on the tabs at the top of the form. Click on the 'Close' button to return to the main form.

Note: Tightening is by head rotation with the nut stationary.
Joint Analysis using the BOLTCALC Program (continued)

(Side) By scrolling down the form the results can be displayed. It will be seen that all safety factors are above 1 except for the surface pressure analysis. If this is not resolved it is likely that excessive embedding loss will be experienced. One simple way to resolve the problem is to use flanged fasteners. Go back to the Bolt Details page of the data entry form.

To change the type nut - click on the Flange Nut button under the nut details section. To change the bolt - click the Flanged Head button. The values shown on the form should reflect the new sizes. Click the 'Calculate' button to see what effect this will give.

(Below) As can be seen the effect of the flanged head fasteners is to reduce the bearing stress to an acceptable level. To check the joint drawing - click on the speed button, or use the View menu. The drawing should reflect that flanged fasteners are being used.

Example Complex Joint

(Side) The engine mounting joint shown is significantly more complicated than the previous example and consists of a number of plates, washers and a tube. The following shows how BOLTCALC analyses the joint.
Joint Analysis using the BOLTCALC Program (continued)

(Side) Go to the Forces pages and click on the button marked 'Additional Assistance on Shear Force Determination' to allow the shear force to be entered. (Below) On the Shear Force form, enter 2 for the number of shear planes and 5000 as the shear load. Click the Calculate button to establish that 12500 N is needed to prevent slip. Click the 'Ok' button.

(Below) On the Bolt Details page click on the button 'Select Thread Size from a Database' and select the M10 x 1.5 thread. The information will be transferred on to this page. Click the 'Property Details' tab at the top to move to the next page. (Below) On the Property Details page click on the button 'Consult the Fastener Material Database' and select the property class 10.9. The information will be transferred on to this page. (Below side) On the Joint Details page click on the button 'Multi-Plate Analysis' to allow the joint details to be entered.
Joint Analysis using the BOLTCALC Program (continued)

(Side) The Joint Details Form will appear. This form allows each plate of the joint to be entered in sequence starting from the joint item next to the bolt head.

(Below) Start by entering details of the washer next to bolt head. Click on the button marked ‘Next Joint Item’ to move to the next item.

(Below Side) Place 14 in the box above and continue adding each layer of the joint to the form. The data can be edited directly using the table at the bottom of the form. The sequence in which the entries are made is important. When complete, click the ‘Ok’ button.

(Side) On the Tightening Details page, click on the radio button marked ‘Tightening Torque’.

(Below) The Tightening Torque Specification Form allows upper and lower tightening torque values to be entered. Enter 53.1 as the lower value and 71.9 as the upper value. Click on the ‘Ok’ button.
Joint Analysis using the BOLTCALC Program (continued)

(Side) On the Tightening Details Page, click on the button marked ‘Determine the Tightening Factor based upon Frictional Scatter’.

There are two ways the program can allow for preload variation. One is by use of a tightening factor and the other is by determining the preload variation directly from the torque and frictional variations. In this example, we are going to use the latter.

(Below) This form allows details about the friction conditions to be included. Accept the default values and click the ‘Ok’ button.

(Side) Click the ‘Calculate’ button from the data entry form and the results will be displayed on the main form. As can be seen there is a bearing stress problem. To check the validity of the data - click on the speed button shown to view a joint drawing.

(Side) A view of the joint will be displayed that should look like the one shown. Other charts such as the Torque-Force Graph and the Preload Requirement Chart can provide some useful information about the joint.
Joint Analysis using the BOLTCALC Program (continued)

(Side) The Tightening Torque - Assembly Preload Graph shows how the preload varies with the torque and friction value. The torque - preload combination can fall anywhere in the region shown.

(Below) The Preload Requirement Chart shows the preload variation relative to the preload requirement and what this requirement is comprises.

(Above) To view a summary of all the results, click on the speed button (or alternatively select the option from the File menu) and follow the on-screen instructions.

(Side) BOLTCALC will launch your default browser and the results will be displayed. This single page summary provides a useful document for recording the analysis for archival purposes.

(Next Page) A summary of the analysis for this joint is shown on the next page.
**Engine Mounting Joint**

**Calculation Reference:** 1  
**Load Case Ref:** 1  
**Analyst:** Bill Eccles - Bolt Science  
**Requestor:** A. N. Other

**Comments:** Example analysis

<table>
<thead>
<tr>
<th>Fastener</th>
<th>Property Grade = 10.9</th>
</tr>
</thead>
<tbody>
<tr>
<td>M10 x 1.5 Coarse Thread</td>
<td>Stress Area = 57.990 mm²</td>
</tr>
<tr>
<td></td>
<td>Min. Yield Strength = 940.00 N/mm²</td>
</tr>
<tr>
<td></td>
<td>Proof Load = 48131 N</td>
</tr>
<tr>
<td></td>
<td>Min. Tensile Strength = 1040.00 N/mm²</td>
</tr>
</tbody>
</table>

**JOINT ASSEMBLY DETAILS**

<table>
<thead>
<tr>
<th>Thread Condition: Dacromet Finish</th>
<th>Min/Max Thread Friction Values = 0.120 / 0.180</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head Condition: Dacromet Finish</td>
<td>Number of Slip Planes = 2.0</td>
</tr>
</tbody>
</table>

**Torque Values**

- **Torque to reach minimum yield = 78 Nm**
- **Estimated Torque to reach maximum yield = 116 Nm**
- **Torque Specification = 62.5 Nm ± 9.4 Nm**
- **Minimum Tightening Torque = 53.10 Nm**
- **Maximum Tightening Torque = 71.90 Nm**

**Bolt Preload Values**

- **Minimum Preload = 21319 N**
- **Maximum Preload = 41321 N**
- **Clamp Force required to prevent shear movement = 12500 N**
- **Force required for functional reasons (e.g. clevis pull up, gasket prestress, etc.) = 0 N**

**DETAILS OF APPLIED FORCES**

- **Axial Force = 0 N**
- **Direct Shear Force = 5000 N**
- **Lower value of the applied axial dynamic force = 0 N (Used in fatigue analysis.)**
- **Clamp Force required to prevent shear movement = 12500 N**
- **Force required for functional reasons (e.g. clevis pull up, gasket prestress, etc.) = 0 N**

**JOINT ANALYSIS RESULTS**

<table>
<thead>
<tr>
<th>Joint Item</th>
<th>Thickness</th>
<th>Compressive Yield</th>
<th>Bearing Stress Face A</th>
<th>Bearing Stress Face B</th>
<th>Compressive Yield Force Face A</th>
<th>Compressive Yield Force Face B</th>
<th>Factor of Safety</th>
</tr>
</thead>
<tbody>
<tr>
<td>Washer</td>
<td>3.000 mm</td>
<td>540.00 N/mm²</td>
<td>342.32 N/mm²</td>
<td>178.19 N/mm²</td>
<td>65182 N</td>
<td>125219 N</td>
<td>1.58</td>
</tr>
<tr>
<td>Inner Support</td>
<td>4.000 mm</td>
<td>120.00 N/mm²</td>
<td>178.19 N/mm²</td>
<td>155.16 N/mm²</td>
<td>27826 N</td>
<td>31956 N</td>
<td>0.67</td>
</tr>
<tr>
<td>Steel bush support</td>
<td>2.200 mm</td>
<td>460.00 N/mm²</td>
<td>227.75 N/mm²</td>
<td>227.75 N/mm²</td>
<td>83456 N</td>
<td>83456 N</td>
<td>2.02</td>
</tr>
<tr>
<td>Bush tube</td>
<td>45.000 mm</td>
<td>460.00 N/mm²</td>
<td>227.75 N/mm²</td>
<td>227.75 N/mm²</td>
<td>83456 N</td>
<td>83456 N</td>
<td>2.02</td>
</tr>
<tr>
<td>Steel bush support</td>
<td>2.200 mm</td>
<td>460.00 N/mm²</td>
<td>227.75 N/mm²</td>
<td>155.16 N/mm²</td>
<td>83456 N</td>
<td>122499 N</td>
<td>2.02</td>
</tr>
<tr>
<td>Outer support</td>
<td>6.000 mm</td>
<td>120.00 N/mm²</td>
<td>178.19 N/mm²</td>
<td>155.16 N/mm²</td>
<td>31956 N</td>
<td>27826 N</td>
<td>0.67</td>
</tr>
<tr>
<td>Washer</td>
<td>3.000 mm</td>
<td>540.00 N/mm²</td>
<td>342.32 N/mm²</td>
<td>178.19 N/mm²</td>
<td>125219 N</td>
<td>65182 N</td>
<td>1.58</td>
</tr>
</tbody>
</table>
| Total Joint Thickness = 65.400 mm | Minimum Factor of Safety on Bearing Stress within Joint = 0.67

**Conclusion:** The bearing stress exceeds the compressive yield strength - deformation may result leading to excessive preload loss.